
How To Secure Your Passwords in the New Year
With the approaching new year, it might be time to start thinking about ways that you can improve your life. Some common resolutions include losing 
weight, exercising more and spending less. Have you considered bettering your digital life as well? Why not take steps to make it more secure? One 
of the easiest ways to do this is by using strong and complex passwords and change them often. 

Update Passwords Regularly. 
When was the last time you updated your passwords? If the answer to this question is more than 30 days ago, it’s time for a change. Some people 
use passwords for years or until a system requires they update them. This could have serious consequences to your privacy. For this reason, it’s 
essential that you update your passwords frequently. It’s much easier to break a password that’s remained unchanged than it is to crack a password 
that’s changed each month. 

Invest in a Password Bank. 
I know – I can hear you now: “I’m too busy to constantly change passwords and keep track of them.”  This is no excuse – especially because there are 
applications you can use called password banks.  A password bank, like LastPass or DashLane can help you keep track of the passwords you use and 
what accounts they’re associated with. Both free and upgraded versions are available. 

Carefully Craft Your Passwords. 
If your passwords are simple they’re more likely to be discovered. It’s important that you create long and complex passwords, with a mix of upper and 
lower-case letters, numbers, and symbols when permitted. 

Use Two-Factor Authentication. 
Two-factor authentication also referred to as multi-factor authentication, uses verification in two forms to prevent unauthorized individuals from 
accessing your private information. With two-factor authentication, you use an initial password login and a secondary one. In addition to entering 
your username and password, you must enter a designated code that’s been sent as a text to your phone. 

And remember, securing passwords is something you should do year-round, not just for the new year. {Company} can help. If you 
are interested in learning more about password security, contact us today at {phone}, or click here to fill out a quick form so we can 
better assist you. 
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Everyone with something to market, whether it is a business, service or product 
wants to stand out and get the public’s attention. We want to be the website that 
people visit for whatever it is that we are selling. Social media can be a great way 
to get our product or business out there to the public, but it’s not always easy. The 
social media landscape can be exciting but it can also be scary and a bit frustrating. 
So how do we navigate this landscape and get the results that we so desperately 
want? 
 
Having an active presence on multiple social media platforms, such as Facebook, 
Twitter or LinkedIn can give you that edge your business needs so badly. But 
handling one social media platform can be daunting enough but multiple can  
be downright overwhelming. You need a way to automate the process and 
streamline your efforts. Lucky for you, there are quite a few sites/apps out there 
that can do this automation for you. From well-known names like Buffer and 
Hootsuite to more obscure ones such as TweetDeck and Dlvr.it. 
 
Here are a few of our picks to make your social media marketing less 
stressful: 
 
HOOTSUITE 
It doesn’t matter if you are an agency handling hundreds of social media accounts 
or a single person handling only a few, Hootsuite makes it simple. Adding accounts 
is easy, as is scheduling posts to go out. You can even add more than one account 
manager to help handle the workload. There is even a training program to teach 
you the ins and outs of social media marketing as well as how to use Hootsuite 
effectively. One of the best at what it does, and for the price, it’s hard to beat. 
 
BUFFER 
Utilizing all the best social media platforms, Buffer allows you to manage and 
schedule posts, but it also allows you to customize posts to each different social 
media platform it’s going out to. This is good for tailoring posts individually for say 
Facebook and Twitter, rather than the two being the same. It also looks more 
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Tools Businesses Can Use to Automate Their Social Media Presence Today 

Tech Tip of the Month:  
Time-Saving Tips For Microsoft Word 
Using Word more efficiently is 
as easy as figuring out the 
tricks, shortcuts, and features 
that can make simple tasks 
even simpler. 

Microsoft Word is not exactly a new program, 
having been on the market since the early days of 
home PCs. However, new versions have come out 
over the years, each adding something a little 
different into the mix. Despite the ways the 
program has changed, most users are still relying 
on the handful of basic keyboard shortcuts and 
little style and format tricks they picked up ages 
ago, not realizing just how much they don’t know. 
 
Stop doing things the hard way. Check out these 
time-saving Microsoft Word tips, and start putting 
them to work for you. 
 
Cut Down On Your Keystrokes With AutoText 
The AutoText function not only saves you time, 
but it reduces the potential for embarrassing 
typos. Frequently used text or graphics can be 
made into AutoText entries, and shared across 
your entire organization. All you have to do is type 
or insert the text or graphic into your Word 
document, then select the content and hit Alt+F3. 
Give your AutoText entry a shorthand you’ll 
remember easily (if it’s a client’s name, make the 
shorthand ‘rgc’ instead of ‘Really Great Company,’ 
etc.) and Word will store the AutoText in your 
Normal template. To use an AutoText shortcut, 
type the shorthand and hit F3, and Word will 
automatically insert the correct text or graphic. 
 
Make Use Of The AutoCorrect Function 
This feature can automatically fix little mistakes for 
you, like switching ‘adn’ to ‘and,’ but it can be 
even more useful when you take advantage of the 
custom dictionary. You can set AutoCorrect to 
correct words you frequently mistype by clicking 
the File tab and choosing Options. Choose 
Proofing from the left pane, then click 
AutoCorrect Options. There, you can add the 
words you want to have automatically replaced. 
The misspelling under Replace, and the correct 
spelling under With, and you’re all set. Add as 
many words as you need to. 
 
Customise You Paste Defaults 
The whole point of using copy and paste is to save 
you time, so when pasting text from another 
source into a Word document means you need to 
fix the formatting to match the rest of your 
document? You can fix that, however, by using the 
Keep Text Only feature in the Paste drop-down – 
meaning you’ll need to right-click on the 
highlighted text instead of using the keyboard 
shortcut. If you keep forgetting to use this trick, 
you can also change Word’s default settings by 
clicking Options under the File Tab.  

 

Data has long been your business’ most valuable and essential asset, and Business 
Intelligence (BI) solutions are changing the way you use that data. A modern BI 
approach is a sure-fire way to lift your business above your competitors, using 
savvy analytics to make better data-driven decisions. There are a ton of fantastic 
and innovative BI technologies and strategies available to today’s businesses, and 
these 10 trends are projected to lead the pack heading into 2018. 
 
Artificial Intelligence and Machine Learning 
Science Fiction paints a pretty terrifying picture of what advancements in AI will 
mean for humankind, but in reality, this technology is already proving to be a huge 
asset to analysts. As machine learning technology continues to improve, it’s 
becoming easier to automate tasks that would otherwise be labour-intensive time 
sucks for your staff. With the tedious work done for them, analysts can instead 
focus on thinking strategically about the implications of their results, and start 
planning next steps for your business. 
 
Natural Language Processing (NLP) 
It’s estimated that half of all analytical queries will be generated using voice, search, 
or NLP by 2020. The power of NLP will allow staff to pose more nuanced questions 
of your data, and get more accurate and helpful responses as a result. While this is 
exciting enough on its own, the real gains where analytics are concerned will come 
from what developers and engineers alike are able to learn from looking closer at 
how people are using NLP. That way, we can make sure NLP is being applied to 
the types of workflows where it can have maximum impact. 
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Undo Styles 
There are other ways to remove source formatting 
if you can’t change your paste default by changing 
the copied text itself. Highlight the text you want to 
paste and either hit Ctrl+Spacebar or click Normal 
in the Styles gallery to leave yourself with plain text. 
 
Use Real-Time Collaboration 
If you’re using a version of Office 365 or Office 
2016, there are a whole host of great collaborative 
features available to you. By saving a Word 
document to OneDrive, OneDrive for Business, or 
SharePoint, you can simply click Share in the upper 
right-hand corner and either enter or choose the 
people you want to collaborate with. They’ll be 
granted access to the document, and can then read 
and edit said document along with you in real-time. 
You’ll be able to see who is doing what so there 
won’t be any confusion. This can save a ton of time 
since you won’t need to email documents back and 
forth or hope that everyone is still using the correct 
version along the way. 
 
Pose Your Questions To Tell Me 
This new help tool keeps things simple by letting 
you ask questions in plain language, offering 
responses that best fit with what you’ve typed in. 
Sometime you’ll get a link to a feature, other times 
you’ll get a block of text. Either way, it’s quick and 
easy. 
 
Use Templates For Consistency And Design Help 
There are a large number of free templates 
available for download, but if you can’t find what 
you need, you can easily tweak an existing template 
to get what you want. It’s much faster than starting 
from scratch and does a lot of the hard work for 
you. Any time you start a new project, remember 
this option exists and take a look at what your 
options are by searching for Office Templates and 
Themes online. 
 
Use The Word Mobile App 
Mobile apps come with some Office 365 
subscriptions, and the word app lets you view, edit, 
and create documents on the go from a mobile 
device. While it doesn’t have many of the features 
that the online or desktop versions do, it’s a good 
starting point since it allows for formatting 
consistency. More importantly, it’s easy and 
convenient. 
 
Customise Your Table Format Default 
If you frequently use the same custom table format, 
make it your default to save yourself a little time. If 
it’s a format that already exists, right-click on it in 
the Table Styles gallery in the Design tab and 
choose Set As Default. If it’s a style you created 
yourself, create it again and set it as the default. 
 
Want to learn more about how you can get the 
most out of your Microsoft programmes and 
tools? Contact {company} at {email} or {phone}. 
We’re the Microsoft experts businesses in {city} 
trust. 

Getting more out of your business data is quickly becoming an industry all its own, and there are some exciting things on the horizon to help you do more, 
learn more, and grow more. 

See exactly how you can get 
your job done in a more 

efficient and cost-effective way.  
 

BOOK YOUR FREE 
IT COST ANALYSIS 

Contact us at 
{email} or {phone} 

"Whatever you do, throw 
yourself into it. Throw your 

head, heart, and hands into it." 
~ Pepsi CEO Indra Nooyi 

 
 "The most effective way to do it, 

is to do it.” 
~ Amelia Earhart 

Crowdsourced Data Governance 
Self-service analytics are gaining popularity, granting users access to new  
perspectives and new information that is inspiring more innovative ways to  
implement governance. More than just using the wisdom of the crowd to get 
your hand on the right data, governance is about making sure the wrong data 
stays out of your system. BI solutions and analytics will be making use of this 
modern governance model in 2018, giving IT departments and data engineers 
the ability to cultivate trusted data sources. 
 
Multi-Cloud Strategies 
There has been an ongoing debate about multi-cloud solutions as more and 
more businesses sour on the idea of being tied to a single cloud solution. Multi-
cloud strategies allow for business to work with multiple providers, finding the 
right vendor for a specific project or need. This increased flexibility comes with a 
higher overhead cost and requires your IT personnel to become familiar with 
multiple platforms. 
 
Liberal Arts in the Analytics Industry 
The need for technology specialties is decreasing as technology platforms 
become easier to use. As a result, businesses are looking to other specialties such 
as the liberal arts to bring new perspectives into the mix.  
 
Want to learn more about the value Business Intelligence solutions can 
offer your business? Contact {company} at {email} or {phone}. We’re the 
IT professionals businesses in {city} trust. 

professional that way. It also shares your content at the best possible times for the 
platform, getting your content out to as many people as possible. Plus, Buffer tracks 
your posts so that you can see what posts and what time of day are getting the 
most traffic. 
 
HUBSPOT 
Hubspot allows you to not only post and review, but it offers you closed-loop 
reporting data. This means that you are able to see down the funnel of  
engagement and find out what posts and channels are driving actual leads that 
translate into sales. 
 
TWEETDECK 
TweetDeck is one that has been around for a while. It’s priced well, (free is always 
good) and is a great way to be part of Twitter. The app is laid out with multiple 
columns, allowing you to follow several conversations at once. Plus, scheduling 
posts is simple and easy. Keeping up with Twitter can be difficult since it moves so 
fast and there is so much to see. TweetDeck makes that easier. 
 
HUMAN BEINGS 
Keeping up with trends and staying relevant on social media can be hard to do. 
This is especially true if you are trying to do it all yourself, along with all the other 
duties you assign yourself. Only using a service or app to schedule posts for you 
aren’t going to get you the relevance or market share you want. The best thing you 
can do for that is to implement a social media manager. Having a person dedicated 
to watching social media and staying up with trends will go a long way to keeping 
your brand out front and relevant. This person can be much more fluid and 
engaging than anything else, since their entire job is social media. 
 
Social media can be frustrating and tough to keep up with the repetitive 
tasks. Automating the process can help a great deal, and there’s no  
substitution for a great social media manager to stay on top of trends and 
responding to feedback. 
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Everyone with something to market, whether it is a business, service or product 
wants to stand out and get the public’s attention. We want to be the website that
people visit for whatever it is that we are selling. Social media can be a great way 
to get our product or business out there to the public, but it’s not always easy. The 
social media landscape can be exciting but it can also be scary and a bit frustrating. 
So how do we navigate this landscape and get the results that we so desperately 
want?

Having an active presence on multiple social media platforms, such as Facebook, 
Twitter or LinkedIn can give you that edge your business needs so badly. But
handling one social media platform can be daunting enough but multiple can 
be downright overwhelming. You need a way to automate the process and
streamline your efforts. Lucky for you, there are quite a few sites/apps out there 
that can do this automation for you. From well-known names like Buffer and
Hootsuite to more obscure ones such as TweetDeck and Dlvr.it. 

Here are a few of our picks to make your social media marketing less 
stressful: 

HOOTSUITE
It doesn’t matter if you are an agency handling hundreds of social media accounts
or a single person handling only a few, Hootsuite makes it simple. Adding accounts 
is easy, as is scheduling posts to go out. You can even add more than one account
manager to help handle the workload. There is even a training program to teach
you the ins and outs of social media marketing as well as how to use Hootsuite 
effectively. One of the best at what it does, and for the price, it’s hard to beat. 

BUFFER
Utilizing all the best social media platforms, Buffer allows you to manage and 
schedule posts, but it also allows you to customize posts to each different social 
media platform it’s going out to. This is good for tailoring posts individually for say
Facebook and Twitter, rather than the two being the same. It also looks more 
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Tools Businesses Can Use to Automate Their Social Media Presence Today 

Tech Tip of the Month:  
Time-Saving Tips For Microsoft Word 
Using Word more efficiently is 
as easy as figuring out the 
tricks, shortcuts, and features 
that can make simple tasks 
even simpler. 

Microsoft Word is not exactly a new program, 
having been on the market since the early days of 
home PCs. However, new versions have come out 
over the years, each adding something a little 
different into the mix. Despite the ways the 
program has changed, most users are still relying 
on the handful of basic keyboard shortcuts and 
little style and format tricks they picked up ages 
ago, not realizing just how much they don’t know. 

Stop doing things the hard way. Check out these 
time-saving Microsoft Word tips, and start putting 
them to work for you. 

Cut Down On Your Keystrokes With AutoText 
The AutoText function not only saves you time, 
but it reduces the potential for embarrassing 
typos. Frequently used text or graphics can be 
made into AutoText entries, and shared across 
your entire organization. All you have to do is type 
or insert the text or graphic into your Word 
document, then select the content and hit Alt+F3. 
Give your AutoText entry a shorthand you’ll 
remember easily (if it’s a client’s name, make the 
shorthand ‘rgc’ instead of ‘Really Great Company,’ 
etc.) and Word will store the AutoText in your 
Normal template. To use an AutoText shortcut, 
type the shorthand and hit F3, and Word will 
automatically insert the correct text or graphic. 

Make Use Of The AutoCorrect Function 
This feature can automatically fix little mistakes for 
you, like switching ‘adn’ to ‘and,’ but it can be 
even more useful when you take advantage of the 
custom dictionary. You can set AutoCorrect to 
correct words you frequently mistype by clicking 
the File tab and choosing Options. Choose 
Proofing from the left pane, then click 
AutoCorrect Options. There, you can add the 
words you want to have automatically replaced. 
The misspelling under Replace, and the correct 
spelling under With, and you’re all set. Add as 
many words as you need to. 

Customise You Paste Defaults 
The whole point of using copy and paste is to save 
you time, so when pasting text from another 
source into a Word document means you need to 
fix the formatting to match the rest of your 
document? You can fix that, however, by using the 
Keep Text Only feature in the Paste drop-down – 
meaning you’ll need to right-click on the 
highlighted text instead of using the keyboard 
shortcut. If you keep forgetting to use this trick, 
you can also change Word’s default settings by 
clicking Options under the File Tab.  

Data has long been your business’ most valuable and essential asset, and Business 
Intelligence (BI) solutions are changing the way you use that data. A modern BI 
approach is a sure-fire way to lift your business above your competitors, using 
savvy analytics to make better data-driven decisions. There are a ton of fantastic
and innovative BI technologies and strategies available to today’s businesses, and
these 10 trends are projected to lead the pack heading into 2018. 

Artificial Intelligence and Machine Learning 
Science Fiction paints a pretty terrifying picture of what advancements in AI will 
mean for humankind, but in reality, this technology is already proving to be a huge 
asset to analysts. As machine learning technology continues to improve, it’s 
becoming easier to automate tasks that would otherwise be labour-intensive time
sucks for your staff. With the tedious work done for them, analysts can instead 
focus on thinking strategically about the implications of their results, and start 
planning next steps for your business. 

Natural Language Processing (NLP)
It’s estimated that half of all analytical queries will be generated using voice, search, 
or NLP by 2020. The power of NLP will allow staff to pose more nuanced questions 
of your data, and get more accurate and helpful responses as a result. While this is 
exciting enough on its own, the real gains where analytics are concerned will come 
from what developers and engineers alike are able to learn from looking closer at 
how people are using NLP. That way, we can make sure NLP is being applied to
the types of workflows where it can have maximum impact. 
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Undo Styles 
There are other ways to remove source formatting 
if you can’t change your paste default by changing 
the copied text itself. Highlight the text you want to 
paste and either hit Ctrl+Spacebar or click Normal 
in the Styles gallery to leave yourself with plain text. 

Use Real-Time Collaboration 
If you’re using a version of Office 365 or Office 
2016, there are a whole host of great collaborative 
features available to you. By saving a Word 
document to OneDrive, OneDrive for Business, or 
SharePoint, you can simply click Share in the upper 
right-hand corner and either enter or choose the 
people you want to collaborate with. They’ll be 
granted access to the document, and can then read 
and edit said document along with you in real-time. 
You’ll be able to see who is doing what so there 
won’t be any confusion. This can save a ton of time 
since you won’t need to email documents back and 
forth or hope that everyone is still using the correct 
version along the way. 

Pose Your Questions To Tell Me 
This new help tool keeps things simple by letting 
you ask questions in plain language, offering 
responses that best fit with what you’ve typed in. 
Sometime you’ll get a link to a feature, other times 
you’ll get a block of text. Either way, it’s quick and 
easy. 

Use Templates For Consistency And Design Help 
There are a large number of free templates 
available for download, but if you can’t find what 
you need, you can easily tweak an existing template 
to get what you want. It’s much faster than starting 
from scratch and does a lot of the hard work for 
you. Any time you start a new project, remember 
this option exists and take a look at what your 
options are by searching for Office Templates and 
Themes online. 

Use The Word Mobile App 
Mobile apps come with some Office 365 
subscriptions, and the word app lets you view, edit, 
and create documents on the go from a mobile 
device. While it doesn’t have many of the features 
that the online or desktop versions do, it’s a good 
starting point since it allows for formatting 
consistency. More importantly, it’s easy and 
convenient. 

Customise Your Table Format Default 
If you frequently use the same custom table format, 
make it your default to save yourself a little time. If 
it’s a format that already exists, right-click on it in 
the Table Styles gallery in the Design tab and 
choose Set As Default. If it’s a style you created 
yourself, create it again and set it as the default. 

Want to learn more about how you can get the 
most out of your Microsoft programmes and 
tools? Contact {company} at {email} or {phone}. 
We’re the Microsoft experts businesses in {city} 
trust. 

Getting more out of your business data is quickly becoming an industry all its own, and there are some exciting things on the horizon to help you do more, 
learn more, and grow more. 

"Whatever you do, throw 
yourself into it. Throw your 

head, heart, and hands into it." 
~ Pepsi CEO Indra Nooyi 

 "The most effective way to do it, 
is to do it.” 

~ Amelia Earhart 

Crowdsourced Data Governance
Self-service analytics are gaining popularity, granting users access to new
perspectives and new information that is inspiring more innovative ways to 
implement governance. More than just using the wisdom of the crowd to get
your hand on the right data, governance is about making sure the wrong data 
stays out of your system. BI solutions and analytics will be making use of this
modern governance model in 2018, giving IT departments and data engineers 
the ability to cultivate trusted data sources. 

Multi-Cloud Strategies
There has been an ongoing debate about multi-cloud solutions as more and
more businesses sour on the idea of being tied to a single cloud solution. Multi-
cloud strategies allow for business to work with multiple providers, finding the 
right vendor for a specific project or need. This increased flexibility comes with a 
higher overhead cost and requires your IT personnel to become familiar with 
multiple platforms. 

Liberal Arts in the Analytics Industry 
The need for technology specialties is decreasing as technology platforms 
become easier to use. As a result, businesses are looking to other specialties such 
as the liberal arts to bring new perspectives into the mix. 

Want to learn more about the value Business Intelligence solutions can 
offer your business? Contact {company} at {email} or {phone}. We’re the 
IT professionals businesses in {city} trust.

professional that way. It also shares your content at the best possible times for the 
platform, getting your content out to as many people as possible. Plus, Buffer tracks 
your posts so that you can see what posts and what time of day are getting the 
most traffic. 

HUBSPOT 
Hubspot allows you to not only post and review, but it offers you closed-loop 
reporting data. This means that you are able to see down the funnel of 
engagement and find out what posts and channels are driving actual leads that 
translate into sales. 

TWEETDECK 
TweetDeck is one that has been around for a while. It’s priced well, (free is always
good) and is a great way to be part of Twitter. The app is laid out with multiple 
columns, allowing you to follow several conversations at once. Plus, scheduling
posts is simple and easy. Keeping up with Twitter can be difficult since it moves so 
fast and there is so much to see. TweetDeck makes that easier. 

HUMAN BEINGS 
Keeping up with trends and staying relevant on social media can be hard to do. 
This is especially true if you are trying to do it all yourself, along with all the other
duties you assign yourself. Only using a service or app to schedule posts for you 
aren’t going to get you the relevance or market share you want. The best thing you 
can do for that is to implement a social media manager. Having a person dedicated
to watching social media and staying up with trends will go a long way to keeping 
your brand out front and relevant. This person can be much more fluid and
engaging than anything else, since their entire job is social media. 

Social media can be frustrating and tough to keep up with the repetitive
tasks. Automating the process can help a great deal, and there’s no 
substitution for a great social media manager to stay on top of trends and 
responding to feedback. 

See exactly how you can get 
your job done in a more 

efficient and cost-effective way. 

BOOK YOUR FREE 
IT COST ANALYSIS 

775.329.2400 or 
sales@aveir.com
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 Tech Times 
How To Secure Your Passwords in the New Year 

 

 

With the approaching new year, it might be time to start thinking about ways that you can improve your life. Some common resolutions include losing 
weight, exercising more and spending less. Have you considered bettering your digital life as well? Why not take steps to make it more secure? One 
of the easiest ways to do this is by using strong and complex passwords and change them often. 
 
Update Passwords Regularly. 
When was the last time you updated your passwords? If the answer to this question is more than 30 days ago, it’s time for a change. Some people 
use passwords for years or until a system requires they update them. This could have serious consequences to your privacy. For this reason, it’s 
essential that you update your passwords frequently. It’s much easier to break a password that’s remained unchanged than it is to crack a password 
that’s changed each month. 
 
Invest in a Password Bank. 
I know – I can hear you now: “I’m too busy to constantly change passwords and keep track of them.”  This is no excuse – especially because there are 
applications you can use called password banks.  A password bank, like LastPass or DashLane can help you keep track of the passwords you use and 
what accounts they’re associated with. Both free and upgraded versions are available. 
 
Carefully Craft Your Passwords. 
If your passwords are simple they’re more likely to be discovered. It’s important that you create long and complex passwords, with a mix of upper and 
lower-case letters, numbers, and symbols when permitted. 
 
Use Two-Factor Authentication. 
Two-factor authentication also referred to as multi-factor authentication, uses verification in two forms to prevent unauthorized individuals from 
accessing your private information. With two-factor authentication, you use an initial password login and a secondary one. In addition to entering 
your username and password, you must enter a designated code that’s been sent as a text to your phone. 
 
And remember, securing passwords is something you should do year-round, not just for the new year. {Company} can help. If you 
are interested in learning more about password security, contact us today at {phone}, or click here to fill out a quick form so we can 
better assist you. 
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